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Purpose of Guide

This Statements Guide covers everything you need to know about Tabs3 Billing statements. This
guide includes information on preparing, generating, finalizing, and updating statements, and more.

A separate Billing Methods Guide includes information on the various client billing methods that
are available in Tabs3 Billing. A separate Statement Formatting Guide includes information for
customizing the look of your Tabs3 Billing statements. Additional guides for separate software
features are also available on our Web site at:

Tabs3.com/support/docs.html

Billing Cycle Overview

Billing in Tabs3 involves several steps. The following provides a general overview of the Tabs3 billing
cycle.

Configure the Client Settings must be defined for the client to determine how
they will be billed, and where statements will be sent to.

Add Fees, Costs, and Payments Data entry in Tabs3 Billing is performed in the Fee, Cost,
and Payment programs. Fees and costs can also be
entered via PracticeMaster. Timekeepers enter their work
over the course of the billing cycle, specifying the date,
transaction code, and hours worked for each fee, and the
date, transaction code, and units for each cost. Data entry
is done on an ongoing basis throughout the billing cycle.

Run Reports and Make Some billing methods require that transactions be

Adjustments adjusted prior to billing, such as flat fee billing and split
billing. Other billing types require use of the Write-
Up/Write-Down program. More information on
adjustments can be found in the Billing Methods Guide
as well as in the Billing Adjustments Guide. Once you
have completed your adjustments, you can generate pre-
bills for the adjusted clients as needed for review.
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Generate Pre-Bills

Review Pre-Bills

Generate Final Statements

Update Statements

Distribute Statements

Once you are ready to start generating bills, it's time to
make sure the data was entered correctly. You can use
either Draft Statements or the Detail Work-In-Process
Report to provide pre-bill information for your
timekeepers to review for accuracy. Additionally, you can
use the Pre-Bill Tracking feature in Tabs3 Billing to track
which pre-bills have been returned.

After you have generated your pre-bills, you can distribute
them to the appropriate timekeepers. After the
timekeepers return the approved statements, you can
make any necessary edits. Once all the necessary changes
have been made, you can proceed to the next phase.

Once all of the information on your pre-bills has been
approved, it's time to run final statements. Running final
statements begins the process of moving the transactions
included on the statement from a status of "work-in-
process” to a status of "billed". This is important because
payments can only be applied to billed transactions.

Updating statements completes the process of moving
transactions from a work-in-process status to a billed
status. Once a statement has been updated, you can apply
payments to the billed transactions. Additionally, the
Update Statements process applies any previously entered
unapplied payments.

Once your statements have been updated, you can
distribute them to their respective clients. Methods of
distributing statements can include mailing printed
statements, e-mailing electronic files, or submitting bills
electronically via the Tabs3 Taskbill software.
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Client Configuration

The first step to ensuring your clients are billed as desired is configuring the client settings that
affect when statements are generated, and whether they are printed or e-mailed.

Billing Frequency

Billing frequencies are used to define how often a client
is billed (monthly, quarterly, etc.). The billing frequency
can be used for selecting batches or groups of clients

when running statements and reports. The billing

frequency is assigned to clients on the Setup tab of the

Client file. Examples of billing frequencies include

“monthly,

"o "o "o

quarterly,” "annually,

“contingency,” "hold,” etc.

» To change the Billing Frequency

> W

standard,”

. %
Client Information ]

" Wiliams/Jlohn £
Client 1D: 101.00 -

- State v. Wiliams ,}

Settings }

Biling Categorny: 50 - Criminal Law %

Biling Frequency:  Mornthly 1

Figure 1, Client File - Billing Frequency

From the Tabs3 Billing Task Folder, click the Client tab and then click the Client icon.

Select the desired Client ID.
Click the Setup tab.
Select the desired Billing Frequency.

Click E to save the client.
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Release to Bill and Bill on Demand
The Release To Bill and Bill On Demand check boxes on the Billing Preferences tab of the Client file
determine whether a statement will be included the next time statements are generated.

Release To Bill If the Release To Bill check box on the Billing Preferences

tab of the Client file is cleared, then the client will not have
a statement printed regardless of whether the client has a
previous balance or work-in-process. This check box must
be selected in order to have a statement printed.

Bill On Demand if the Bill On Demand check box is selected, the Release

To Bill check box will automatically be cleared when the
Update Statements program is run. This is done to prevent
the client from automatically being billed the next time
batch statements are printed. Clients with a status of Bill
On Demand are usually billed by running single
statements instead of being billed in a batch.

£ 3
Client Information {
Address | Setup I Rates I A

Billing Options | Billing Preferences i
Larson,/Micha?

Cliert 1D: 100.00 rson/Hicha
© Larson v. Bel 3
Billing Status |
5
[ Release To Bil Bill On Demand ]
B s e dh

Figure 2, Client File - Billing Status

» To release a client to bill

1
2
3.
4

From the Tabs3 Billing Task Folder, click the Client tab and then click the Client icon.
Select the desired Client ID.
Click the Billing Preference tab.

Select the Release to Bill check box.

Click E to save the client.
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Statement Delivery Options

Statements can be set up to
be printed and mailed, saved

B Client Information

| Address I Setup | Rates I A/R & Fund Balances I Cliert Notes |
as a PDF and e-mailed, or Biling Cptions Biling Freferences | Statement Options | Spit Biling |
. " . in MegaConstruction Comporation
both. Statement Dellvery Client D: 415.00 Comorate Merger - Megabuilders and
Options are specified on the Biling Status
Billing Preferences tab Of the Release To Bill [ Bil On Demand Progress Biling
Client file in individual Bill To Bling Notes & -

Instructions
Spell
¥4 i

Statement Delivery Options

records. You can double-click
a Bill To record in the table to
review or edit it.

Bill To Marme

Description

[ Use a password to protect PDF statemerts when e-maied:

T ettt A it A S g U T o g e et

Figure 3, Client File - Billing Preferences tab

Bill To Records

Bill To records consist of information associated with a recipient of a client’'s mailed or e-mailed
statement. Each Bill To record is associated with a contact (except when associated with a secure
client). Bill To records include additional billing information not stored in the Contact file, such as
whether a statement will be mailed and/or e-mailed, which mailing address or e-mail address will be
used, whether an Attention line is included, and more.
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An additional Bill To record can be added to

send statements to a different contact. Each
client can have up to two Bill To records.

» To add a Bill To record

1. From the Tabs3 Billing Task Folders, click the Client tab and then click the Client icon.

2. Select the desired Client ID.

("Bill To Record

Bill To Mame:  Tatiki, 5r./dames B. -

Drescription:

Statement Delivery Options
Mail Staterment
/| E-mail Statement
Print the Client's Mame and Address on the Statement

@ Print the Bill To's Mame and Address on the Statement

Statement Address

Business® v | PO Box 72345

201 E 48th Street
Manhattan NY' 100171538

V| Inchide Attention line on statement
@ Matter's Contact Mame: James R. T atiki, Sr.

Other:

E -mail Delivery Options

E-mail 1* - | {Emegaconcorp. com

E-mail Template:  RP& - RPA's Clients

f QK || Cancal || Dielete

James B. Tatiki, Sr.

S S T N P ey U WP e e O WA Ve S U

Figure 4, Bill To Record window

Select whether the contact will receive statements by mail, e-mail, or both.

3.
button.
4. Select a Bill To Name.
5. Enter a Description to help identify this Bill To Record.
6.
7.

selection.

8. Click OK to save the Bill To record.

Select the Statement Address and/or E-mail Delivery Options based on the delivery

You can change whether a statement is mailed or e-mailed at any time.

On the Billing Preferences tab, in the Statement Delivery Options section, click the Add
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» To change whether a statement is mailed or e-mailed

1. From the Tabs3 Billing Task Folders, click the Client tab and then click the Client icon.
2. Select the desired Client ID.

3. On the Billing Preferences tab, in the Statement Delivery Options section, select the
desired Bill To Name.

4. Click the Edit button.
5. In the Statement Delivery Options section, select or clear the desired options.

6. Click OK to save the Bill To record.

Bill To Record T
>

Eil Ta Mame:  Larson/Michael 3
}

Description: Default Biling &ddress for thiz b atter %
Statement D elivery Options ;P
Mail Statement ,5}
E-mail Statement %

=) nd Addrezs on the Statement S

Print the Bill To's Mame and Address on the Statement 3

S I R R

Figure 5, Bill To Record - Statement Delivery Options

More Info: Additional information on Client settings that affect billing and statements can be
found in the Billing Methods Guide and the Statement Formatting Guide.
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Data Entry

When entering transactions, the Bill Code and Status fields determine whether the transaction is
billed or shown on the statement.

Bill Code

The Bill Code indicates whether the transaction is billable or non-billable (i.e., no charge), and the
printing status.

The following Bill Codes are available for fee and cost entry:

Billable/Printable
Non-Billable/Non-Printable
Non-Billable/Printable
Billable/Non-Printable
Billable/Always Print

Non-printable transactions will not be shown on a statement regardless of whether they are billable
or non-billable. Likewise, non-billable transactions will not incur a charge on the statement,
regardless of whether they are printable or non-printable. Bill Codes are not available for payments.

. . - e S BIEHED
The majority of transactions entered Rl e et 3
are Billable/Printable. Bill Code: 0 - Billable / Printable - i
[ - Billable /# Printable i
RateCode: 4 WonBillable / Non-Printable i

2 - Mon-Billable / Printable

. 3 - Billable # Mon-Printable Fi
FesEntyList 4 . Billable / Aways Print ¢
Ref . BC H/F Date Tmkr Hrs toBil ."—"m'l?‘l

Figure 6, Client File - Billing Frequency

Status

The Status field determines whether the transaction is eligible mm%"\”"ﬁ‘g}
to print on a statement. It also indicates whether a transaction - 3
has been shown on a final statement but has not yet been Bl [:_:; : ﬁ"?; v] {
£ - Had #

updated. T AT
g 5 - Save L

. Fa

bjﬂ\tﬂ[le_sgnptmn e P

Figure 7, Client File - Billing Frequency
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Hold Puts a transaction on hold and prevents the entry from
being billed until it is changed to a Print status. This status
is available for Fee, Cost, and Payment entry.

Print Allows a transaction to print on a client's statement. New
entries automatically default to Print. This status is
available for Fee, Cost, and Payment entry.

Update Indicates that the transaction has been final billed and is
ready to be updated by the Update Statements program.
You will not be allowed to edit the Status field when
Update is shown. If you want to change this field, you
must first unbill the statement. This status is available for
Fee, Cost, and Payment entry.

Save Has the same function and print status as Print but the
transaction is saved after it has been shown on a final
statement and updated. Instead of being deleted after
printing on a statement, saved transactions remain in the
fee file for repeated billings until they are deleted or
changed to Print. This status is available for Fee and Cost
entry.

Save/Update Indicates that the transaction is a saved transaction that
has been final billed and is ready to be updated by the
Update Statements program. You will not be allowed to
edit the Status field when Save/Update is shown. If you
want to change this field, you must first unbill the
statement. This status is available for Fee and Cost entry.

The majority of transactions are entered with a status of Print.

Statement Preparation

Before generating statements, certain steps are required in order to have correct figures, and some
steps are optional.
e Make sure Release To Bill is selected for all clients for which a statement should be printed.
e Make sure all transactions to be included on a statement are set for Print and not Hold.

e Optionally run Work-In-Process reports to review work that needs to be included on
statements.

e Make adjustments (Write-Up/Down, Flat Fee, Split Fee)
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Making Adjustments

Depending upon how your clients are set up, you may need to run one or more of the following

utilities prior to generating statements:

Write-Up/Write-Down

Adjust Flat Fee Clients

Perform Split Billing

The Write-Up/Write-Down Fees and Costs program allows
you to write-up or write-down total unbilled fees, costs, or
hours for a client for a range of timekeepers, transaction
codes, categories, or dates for a client prior to billing.
Write-ups/write-downs can be adjusted to a specified
amount or by a specified percentage.

The Adjust Flat Fee Clients program allows you to adjust
fee transactions in work-in-process to equal the flat
amount assigned in the Client file. The Adjust Flat Fee
Clients program only adjusts fee transactions for clients
whose Billing Rate Code is “0" (zero). Cost transactions are
not adjusted.

The Perform Split Billing program allows you to split the
fee and cost transactions in work-in-process to equal the
split fee percentages defined on the Split Billing tab of the
Client. This program will copy the transactions to the split
clients and adjust the Hours and Amounts of the specified
transactions.

Billing Methods Guide.

More Info: Additional information on these utilities can be found in Tabs3 Billing Help and in the

Pre-Bills: Detail WIP Report vs. Draft Statements

Most firms run Pre-Bills one of two ways: printing a Detail Work-In-Process Report (Detail

WIP Report), or printing Draft Statements. Both of these options update the Pre-Bill Tracking
program (page 18); however, each option offers different features. The Detail Work-In-Process
Report provides a list of transactions in a report format that includes additional detailed information
for each transaction, whereas draft statements provide a list of transactions in statement format.

-10 -
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Work-in-Process Reports

Menu: Reports | Work-In-Process | Detail Work-In-Process
| Summary Work-In-Process
| Aged Work-In-Process
Task Folders: Statements | Statement Preparation | Detail Work-In-Process
| Summary Work-In-Process
| Aged Work-In-Process

Work-in-Process reports are valuable tools that show all unbilled fees, costs, and payments. Work-
in-Process reports can be run in a detailed or summary format, or to review aged Work-In-Process.
Tabs3 Billing includes the following Work-In-Process reports:

Detail Work-In-Process The Detail Work-In-Process Report shows the detail of all
fees, costs, and payments entered for the client. The
detailed report can be used to review work-in-process
prior to billing. Some firms use Detail Work-In-Process
Reports in lieu of running draft statements.

Summary Work-In-Process The Summary Work-In-Process Report shows the client’s
previous balance and totals for any fees, costs, or
payments in work-in-process. A current balance is
calculated and shown. The client funds balance is shown
as well. This report allows for a quick review of the client's
status.

Aged Work-In-Process The Aged Work-In-Process Report shows the age of all
unbilled charges by client.

» To run a Work-In-Process Report

1. From the Tabs3 Billing Task Folders, click the Statement Preparation tab and then click the
icon for the desired Work-In-Process report.

2. Select the desired report criteria.

3. Click OK.

Generating Statements

Statements are run using the Generate Statements program.

-11 -
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Generate Statements Program

Menu: Statements | Generate Statements
Task Folders: Statements | Generate Statements

The Generate Statements program allows you to print an individual client’s statement or a batch of
clients’ statements in draft or final mode. The Generate Statements program includes a Client tab, a
Transactions tab, an Options tab, and a Sort tab.

i Generate Statements q i Generate Statements ;
3 3
Cliertt | Transactions | Options | Sort ) Transactions | Options | Sort ¢
| 7
Client 1D: ~ Thu: - Fy %
3 Fee Date mm/ddAyyy  + ThUD mmiddAyy < 3
i

Name Search: Theu: ¢ Fee Teode - Theu: <

i Category = Thru: =
Primary Timekeeper: - Thu: pr f i
Pl
Secondary Timekeeper - Thu - L 4
3 Bipensss  Cost Tmekeeper p Thru: 1 ]
Onginating Timekezper: - Th = l Advanegs | Cost Date: e T et | }
Category - Th > ) Cost Teode: = Theu: > H
5 Cast Type Thru: i
Biling Frequency: @A O Speciic { 1
3 3
Location: @Al () Specic H [@] Payments ~ Payment Date: mmiddAyyy - Thu mmdddAwy }

1

Shatus: OM O Speche ) Payment Teode: v Thru: , ‘e
3 2
Open/Close Dates: @ Al () Specific S 3
$ }
3 3
$ {
: j
by 4

Figure 8, Generate Statements Figure 9, Generate Statements

Client tab Transactions tab

i Generate Statements i Generate Statements

CANIEY

Cliert | Transactions | Options | Sort Cliert | Transactions | Options | Sort

Statemert Type Statement Options
@ Draft Statement Date 114142013 -

Report Order Secondary Order
) Primary Timekeeper :
C © Clert 1D
Frint Reference Numbers Beginning Statement Numbsr: 7566 -
Update Pre-Bil Track
poate et Trecting Last Numbers Lised: 7561 th 7565
Print Biling Motes & Instructions

© Final Statement Template

©) Secondary Timekeeper i
- @ Client Name Search
) Originating Timekesper

ing Tir o

s mbe F— © Category
@) None

Print Criteria

Zero Balance Payment Only Clisrts [ Print Reminder Statsmert for Clients Totals

Task Based Biling Information D

[F] Cover Statemert Crly

[ Statement Run Totals -
[ Criteria Page Include Clierts:
(@) with Activty
Output Options ) wihout Actvty
Number of Copies: 1 |+ © Eoh

] PDFs as Individual Statements Select Age of Past Due Clients
{Using DropBex or Print o File/PDF) Threshold Biing

N o oy L WP R Mot U NN L WY LTS

sy e VA Sl i g Pyl i P S S

.

Figure 10, Generate Statements Figure 11, Generate Statements
Options tab Sort tab

-12 -
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Client tab

Transactions tab

Options tab

Sort tab

The Client tab allows you to specify a range of clients,
timekeepers, categories, billing frequencies, locations,
open dates, and close dates. You can also select clients
based on status (i.e., active clients, progress billing clients,
billable clients, e-mail and/or mail clients, and task based
billing clients).

The Transactions tab allows you to specify the
transactions to be included based on transaction type
(fees, costs or payments), date, transaction code, working
timekeeper, category, and cost type.

The Options tab allows you to specify the statement date
and the minimum fee, expense, and advance amounts to
be billed. You can select if you want to print reminder
statements or statements for clients with current work.
You can include only clients with past due amounts
greater than a specified number of days. If you number
statements at the firm level, you will be prompted to enter
the beginning statement number. If you print draft
statements, you can elect to print reference numbers for
the individual transactions, update pre-bill tracking
information, and select whether you want billing notes
and instructions included. You can select whether you
want statements for task based billing clients to include or
exclude task based billing information. You can specify
the number of copies you want printed, and whether or
not you want to include Statement Run Totals and a
Criteria Page. If generating PDF files for statements, you
can elect to generate individual PDF files for the statement
run. You can select to print cover statements only. If
desired, you can override individual statement template
options or specify a different statement template for a
particular batch of statements.

The Sort tab allows you to select the order in which the
information should appear on reports.

When draft statements are displayed using the Preview option, you can drill down to individual
client, fee, cost and payment records allowing you to edit data directly from the Preview window.
When final statements are printed or displayed using the Preview option, e-mail statements are sent
to the E-mail Statements window for review.

Some firms will run batches of statements by timekeeper.

-13 -
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> To generate a batch of statements for a specific primary timekeeper

1

v > W N

From the Tabs3 Billing Task Folders, click the Statements tab and then click the Generate
Statements icon.

From the Client tab, select a Primary Timekeeper range.
From the Options tab, select to print a Draft or Final statement.
Select any other desired options.

Click OK.

Tip: You can generate batch statements for all timekeepers at the same time and have them sorted
by primary timekeeper. To do this, select a Report Order of Primary Timekeeper on the Sort tab.

Which Clients Will Have Statements Printed?

When statements are run, the options selected in the Generate Statements program as well as a
client’s previous balance, work-in-process, and client information settings determine if a statement
will be processed.

Generally, clients with a previous balance or work-in-process that is released for billing will
have a statement processed.

You can select to include clients with work-in-process, without work-in-process, or both. If
desired, reminder statements can easily be printed that will not include current work-in-
process.

If the Release To Bill check box for a client is cleared, then the client will not have a
statement printed regardless of whether the client has a previous balance or work-in-
process. This check box must be selected in order to have a statement printed. Keep in mind
that if the client’s Bill On Demand check box is selected, the Release To Bill option will
automatically be cleared when the Update Statements program is run. This occurs in order to
prevent the client from automatically being billed the next time batch statements are printed.
Clients with a status of Bill On Demand are usually billed by running single statements
instead of being billed in a batch. (Exception: Clients whose Bill On Demand check box is
selected and Release To Bill check box is cleared will have a reminder statement generated.)

If desired, you can also specify threshold billing options at the client level or when printing
statements so that only clients with work-in-process that exceeds a specified amount will be
billed.

When generating e-mail statements for clients, the statements are output to the E-mail
Statements window when running final statements. However, if a client is configured for
both e-mail and mail statements, the statement is printed and sent to the E-mail Statements
window. Draft statements are not sent to the E-mail Statements window.

-14-
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More Info: A checklist of potential reasons why a statement doesn't print can be found in
KB Article R10004, "My Statement Doesn't Print".

Using Report Definitions to Define Batches

Tabs3 Billing allows you to save all of the parameters specified for statement runs and individual
reports as report definitions. This feature saves time when running statements on a regular basis by
streamlining the process of selecting the options.

When saving a report definition, Tabs3 Billing also allows you to specify that the report definition
should be used as the default for the report. The next time any user selects the report, the options
from this report definition will be used by default.

The reports that allow you to create and use report definitions include two buttons in the report
window: the Load button and the Save button.

Load The Load button can be used to retrieve a previously saved
report definition for statements. The Report Definition List
(Figure 12) will be displayed, allowing you to select a
report definition.

Save The Save button can be used to save the specified options
as a report definition. The Save Report Definition window
will be displayed, allowing you to specify a report
definition name and description.

i35 Report Definition List [ | =)
Show All Report Types Show Other Users' Reports
Default Mame Report Type Uszer 1D Description -
v _split Split Billing CATHY Default configuration for Perform Split Biling
v |defstmt | Statements CHERYL | Default Statements
reminder Statements CHERYL Reminder Statement Defaults
v tkadef Trikpr Analsis ML) Timekeeper analysis Default
v tkprof Trikpr Profitabiliby CATHY Timekeeper Prafitability
v attkrea Trikpr Realization ML) Guarterly Timekeeper Realization
w*  tkprod Trkr Prad Rpt ML) Default Timekeeper Productivity
_etl Trans File List ROM Cost TFL for Archive & Ledger don't match
_ftfl Trans File List ROM Fee TFL for Archive & Ledger don't match

[ 0K | [Cancel| [Delete | [Rebuid| [ Help |

Figure 12, Report Definition List

-15-
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Draft vs. Final

One of the most important concepts in Tabs3 Billing is the Stmw
difference between "draft” statements and “final” H Draft f
statements. When running statements, the Options tab is Prirt Ref E:
used to specify whether you are running draft or final i
statements. ?5
|

ot

Draft Statement

Final Statement

Figure 13, Generate Statement window
Draft vs. Final

Draft statements do not alter any information in the data
files and can be run at any time. Because of this, multiple
draft statements for a client can be run at any time during
the billing cycle as needed. When draft statements are
displayed using the Preview option, you can drill down to
individual client, fee, cost, and payment records allowing
you to edit data directly from the Preview window. Many
firms will select the option Print Reference Numbers to
make it easy to quickly look up transactions for editing
purposes.

Final statements can also be run at any time; however,
when final statements are run, the Status field is changed
to U-Update for each transaction included on the
statement. This indicates that the entry has been billed and
is ready to be updated by the Update Statements program.
This "U” can be seen on the Detail Work-In-Process
Report, the Transaction File List and in the Status field
when editing the transactions. You can edit a transaction
that has U-Update in the Status field, but you should
reprocess another final statement that reflects the
changes. You cannot delete a transaction that has U-
Update in the Status field. You must first “unbill” that
client and then you will be allowed to delete the
transaction.

-16 -
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The changes that are made to the data files by running
final statements are not permanent until the Update
Statements program is run. This means that you can run
final statements multiple times. However, whatever
information was shown on the last final statement for the
client is the information that is updated by the Update
Statements program.

Reminder Statements

. . e, T,
Reminder statements can be sent to clients to encourage W ~ me\}
timely payment of past work. Reminder statements are 5 V] Prnt Reminder Statement for Clierts $
. . @ Detail §
generated by selecting the Reminder Statement check box Sur:r'naw 4
on the Options tab of the Statements program. You can With no Statemert Snce:  mmrddAnyy |+ }
select whether you want to use a detail or summary format. TReluge Clerts: ‘}
A summary reminder statement includes the client’s 0 with Activity ’:
. ithout Act {
previous balance and any unprocessed payments, but does gmho i )
P

not include current fees and costs. A detail reminder {

) ) ] ) ) Select Age of Past Due Clients: 31
statement includes this same information as well as a history f [ Theshold Biing | [
showing amounts billed and due for each outstanding e
statement.

Figure 14, Generate Statements window
Reminder Statements

Previous Balance $4,071.00
Simt Date Stmt # Billed Due
08/31/2014 7588 200.00 200.00
0930/2014 7592 723.40 723.40
10/31/2014 7597 3,147.60 3,147.60
4,071.00

Balance Due $4,071.00

Figure 15, Example of a Detail Reminder Statement

Previous Balance $4,071.00

Balance Due 54 071.00

Figure 16, Example of a Summary Reminder Statement
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Tracking Statements

The Pre-Bill Tracking program can be used to track statements to see where they are at in the billing
process. Pre-Bill Tracking uses records generated by running either Work-In-Process reports, or
running Draft statements.

Batch Numbers

Tabs3 Billing automatically assigns a unique batch number to each run of draft statements and each
Detail Work-In-Process Report for use by the Pre-Bill Tracking program. The previous batch number
is automatically incremented by “1," regardless of whether a report or statement actually prints. The
batch number is shown in the Pre-Bill Tracking window. Specific batch numbers can be included in
the Pre-Bill Tracking window. Additionally, pre-bill tracking records can be deleted based on a batch
number.

More info: Steps on running a batch of statements can be found on page 14 of this guide.

Pre-Bill Tracking

Menu: Statements | Pre-Bill Tracking
Task Folders: Statements | Pre-Bill Tracking

The Pre-Bill Tracking program is used to review, modify, or delete the pre-bill tracking records that
have been created by running pre-bills or final statements. Either draft statements or Detail Work-in-
Process Reports can be used as pre-bills. This program makes it easy for the billing clerk to track the
status of individual client's pre-bills and final statements. Records can be easily sorted for a specific
Primary, Secondary, or Originating timekeeper or a range of timekeepers.

If a pre-bill has been run for the client, the date shown on the most recent pre-bill is included in the
“Pre-Bill” column of the Pre-Bill Tracking window. If a final statement has been run for the client, the
date shown on the most recent final statement will be shown in the “Final” column. Pre-Bill Tracking
records can be marked as “on hold” or “reviewed.” Final statements can be printed for selected
clients from within the Pre-Bill Tracking window.

A Pre-Bill Tracking Report can be printed showing the pre-bill tracking records that meet specified
criteria.
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1l Pre-Bill Tracking = =R

Client D Client Marme Dezcription Timekeeper Pre-Bill £ H R Firal Batch «
415.00 MegaConstruction Corporation Corporate Merger - Mec 3 - Ronald P. Anderson 101342014 v 11/15/2014 44
121.01 Phillips/tarcus Real Estate Acquisiion 1 - Michael L. Jenzen 101442014 11/168/2014 45
200.01 Peterson Insurance Co. General Legal Counsel 1 - Michael L. Jensen 101472014 11/15/2014 45
200.02 Peterson Insurance Co. Maintenance of Insurar 3 - Ronald P. Anderson 104142014 ¥ 1115/2014 45
850.01 White/Kelly Last Wil & Testament 5 -Kendra | Michaels 101472014 45
850.02 WhiteKelly Medical Care of Brianne 2 - Paula &nn Martin - 101442014 45 -

Options | | Hald | | Fieviewed | | Final Statements | | Fiefresh | | Frint Repart

Figure 17, Pre-Bill Tracking window

Start Each Timekeeper on a Mew Page

Clicking the Options button in the Pre-Bill ("Pre-Bill Tracking Options ‘]
Tracking window (Figure 17) displays a Pre-Bill Filter ,i’
. . . . 1
Tracking Options window (Figure 18) that lets Include Final B e @ Both 3
you specify exactly which pre-bill tracking Include Hold Exclude Hold @ Eoth i
records to include in the window and on the Pre- Include Reviewsd @) Exclude Reviewed @ Both ,}
Bill Tracking Report. Options include the ability 3
to select the statements on hold, statements ©) All Batch Nurbers 3
outstanding (not reviewed), a specific batch Specific: Batch Number: %
number, and which timekeepers to display. ;
Timekeeper i

@) Primary Secandary Originating %

= Thru - ;‘

1

F

|

Report Dptions ]

3

H

{

Figure 18, Pre-Bill Tracking window

For example, let's say that Mary prints draft statements for primary timekeeper 1 and gives them to
the attorney for approval. As the attorney returns the draft statements to Mary, Mary edits the
transactions as needed, and then she marks the statement as reviewed in the Pre-Bill Tracking
window. Mary can easily see which draft statements, if any, have not yet been returned and can
follow up with the attorney as needed. At any time, Mary can easily run final statement for any or all
of the clients with reviewed statements via the Pre-Bil Tracking window by clicking the Final
Statements button.
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Pre-Bill Tracking Report

The Pre-Bill Tracking Report is accessed from within the Pre-Bill Tracking program and includes the
pre-bill tracking records that are displayed at the time the report is run. The report can be sorted by
Client ID, Client Name, Description, Timekeeper, Pre-Bill Date, Hold Status, Reviewed Status, Final
Date, or Batch by clicking the column header in the Pre-Bill Tracking window. Clicking the Options
button (Figure 18) in the Pre-Bill tracking window allows you to select to print each timekeeper on a
new page if desired.

Date: 11/27/2014 Pre-Bill Tracking Report Page: 1
Jensen, Martin & Anderson

Client MNama Description Pra-BIl Hold Revigwsd Final Batch Thpr
100.00M  Larson/Michael Larson v. Bel-Cor 117142014 117262014 1 1
101.00M  Williams/John State v. Williams 1171472014 1172612014 13 2
121.01M  Phillips/Marcus Real Estate Acquisition 117142014 117262014 1" 1
200.01M Peterson Insurance Co. General Legal Counsel 111142014 11/26/2014 1 1
200.02M Peterson Insurance Co. Maintenance of Insurance Policies 1111472014 112672014 14 3
415.00M MegaConstruction Corporation Corporate Merger - Megabuilders and BuilderCor 111142014 11/26/2014 14 3
B50.00M  White/Kelly Divores 111142014 111262014 15 5
BE0.02ZM  White/Helly Medical Care of Brianne 111472014 1172672014 13 2
BED.0TM  White/Kelly Last Will & Testament 117142014 11/28/2014 15 5

Figure 19, Example of a Pre-Bill Tracking Report

Finalizing Statements

The processing of final statements is a two-step process. The first step consists of running a final
statement; the second step consists of updating the final statement by running the Update
Statements program.

Once a final statement has been generated, you are ready for a final review. You can optionally use
the Pre-Update Statements Report to review which clients will be updated. After reviewing which
clients' statements will be updated, running the Update Statements program is a key step in the
billing process. The Update Statements program archives all transactions that were on the statement,
which means that payments are allocated appropriately, accounts receivable is up to date, and
transactions cannot be billed on another statement.

Pre-Update Statements Report

Menu: Statements | Pre-Update Statements Report
Task Folders: Statements | Pre-Update Stmts Report

The Pre-Update Statements Report is used to print a report showing the amounts that have been
processed on final statements that are ready to be updated by the Update Statements program. The
report shows amounts for previous balance, fees, expenses, advances, finance charge, payments,
and balance due. The statement number and statement date shown on the final statement are
included for each client.
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Date: 117222014 Tabs3 Pre-Update Statements Report Fage: 1
Jensen, Martin & Anderson
Ttmiz Client_Name/Work Decoription Date Prev Bal Feeo Expences Advanset Fin Chg Paymants BalDus
7585 101.00 Williams/Jchn 11152014 2,307 60 1.812.50 0.00 0.00 0.00 -1,382.35 282775 PAM
State v Williams
7583 121.01 PhilipsMarcus 11152014 5,123.85 2,BB7.50 0.00 0.00 0.00 0.0oo £011.35 ML)
Real Estate Acquisition
7581 41500 MegaConstruction Cormporation 11152014 8540022 2484750 0.00 0.00 12441 -20,000.00 90,531.13 RPA
Corporate Merger - Megabuilders and BuilderCorp
7504 E50.00 White/Helly 11152014 275.00 1,165.00 0.00 0.00 0.00 -125.00 1,215.00 KIM
Divorce
7504 E50.01 White/Helly 11152014 1.500.00 250.00 0.00 0.00 0.00 0.0oo 1.750.00 KIM
Last Will & Testament
7504 B850.02 White/Helly 11152014 0.00 337.50 0.00 0.00 0.00 0.0oo 337.50 PAM
Medical Care of Brianne
B50 White/HKelly 1.775.00 1.752.50 0.00 0.00 0.00 -125.00 340250
Total 0472567 31,300.00 T 0.00 18441 -21507.35 104,772.73

Figure 20, An example of the Pre-Update Statements Report

» To run a Pre-Update Statements Report

1. From the Tabs3 Billing Task Folders, click the Statements tab and then click the Pre-Update
Stmts Report icon.

2. From the Client tab, enter the desired Client ID range.
3. Click OK.

Update Statements Program

Menu: Statements | Update Statements
Task Folders: Statements | Update Statements

When the Update Statements program is run, all fee, cost, payment, and client funds transactions
that have been billed on final statements will be updated. You can update one client, a range of
clients, or all clients. You can update clients for a specific primary, secondary, or originating
timekeeper or a range of timekeepers. This program represents an important “turning point” in the
billing cycle. Final statements can be rerun as many times as required until the statement is as
desired. However, once the Update Statements program is run, it essentially finalizes the information
that was included on the client’s last final statement. These transactions are archived and are
removed from work-in-process.

Additionally, the information on the client’s last final statement is updated to accounts receivable
and various other productivity figures. E-mail statements can be e-mailed via the E-mail Statements
window once the attached final statements are updated.
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Unallocated payments are allocated for T Update Statements =8 =n
those clients being billed who previously || ¢ et Repotting Period: 1172013
had no due amounts. -
Client 1D: - Thru: -
Timekeepers

@ Primary

") Secondary  From: - Thiu: &

) Originating

I Ok ‘ [ Cancel ]

Figure 21, Update Statements window

» To update statements
1. From the Tabs3 Billing Task Folders, click the Statements tab and then click the Update
Statements icon.
2. Enter a Client ID range, or leave it blank to include all clients.
Optionally specify a Timekeeper range for which statements are to be updated.

4. Click OK.

Tip: It is important to note that you must run the Update Statements program before running the
productivity and accounts receivable reports. The Update Statements program updates all billed
fees, costs, payments, and retainers (regardless of the Statement Date) to accounts receivable and
the client ledger file as well as the current month'’s timekeeper, category, and transaction code
productivity figures. If productivity or accounts receivable reports are printed before updating, the
reports will not reflect the information from statements printed since the last time the Update
Statements program was run.

Undo Updated Statements

Menu: Statements | Undo Updated Statement | Undo Single Updated Statement
| Undo Multiple Updated Statements
Task Folders: Statements | Undo Single Updated Statement

When a statement is updated, it is finalized and many changes occur to the data files. The Undo
Updated Statements programs reverse these changes by restoring client data to its pre-update status
and unbilling the final statements that were run (i.e., the Status field for transactions on the
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statements is changed back to “Print"). Updated statements for a specific client must be undone in

the reverse order they were updated.

Undo Single Updated Statement

The Undo Single Updated Statement
program can be used to undo a single
statement for a single client.

» To undo a single updated statement

1. From the Tabs3 Billing Task Folders, click the Statements tab and then click the Undo Single

Updated Statement icon.

‘- Undo Single Updated Statement

Cliert 10 =

Statement Mumber: -

Statement Information

Statement D ate:

Fees: Fee Tax:
Expenzes: Expenze Taw:
Advances: Advance Tax
Finance Charge: FPayments:

Month to Adjust
Adjust period-bazed productivity reports for the following month;
@ Current Reparting Month: 1172014

Original Reparting Month in which the statement waz updated:

[ate-baszed reports that included the specified statement date must be rerun
to reflect thiz change.

| oK | [ Cancel ]

Figure 22, Undo Single Updated Statement window

2. Enter the desired Client ID. The most recent Statement Number is automatically selected.

3. In the Month to Adjust section, select the period to adjust.

4. Click OK.
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Undo Multiple Updated Statements

Undo Multiple Updated Statements ' Undo Multiple Updated Statements =N IR ==
program can be used to undo statements Statement Criteria
for multiple clients with the same Statement Date:  mm/dd/puy  ~
statement date. Client ID: - Thu = [(Multple... |
Mame Search: Thru:
Primary Timekeeper: - Thu
Secondary Timekeeper: = Thiu:
Originating Timekeeper: = Thiu
Category: = Thiu
Month to Adjust
Adjust period-based productivity reports for the following rmonth.
@ Curent Reporting Month: 1142014

to reflect this change.

Original Reporting Month in which the statement was updated:

(TS

[rate-bazed reports that included the specified statement date must be rerun

Figure 23, Undo Multiple Updated Statement window

» To undo multiple updated statements

1. From the Statements menu, point to Undo Updated Statement and select Undo Multiple

Updated Statements.

Enter any other desired criteria.
In the Month to Adjust section, select the period to adjust.
Click OK.

AR

Unbill Final Statements

Menu: Statements | Unbill Final Statements
Task Folders: Statements | Unbill Final Statements

Enter the Statement Date of the statements you want to be undone.

The Unbill Final Statements program allows you to reverse a final bill if it has not yet been updated.
This feature is useful when a client is unintentionally billed or you decide not to bill a client already.
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When a final statement is run, Tabs3 Billing "tags" the transactions as "ready to be updated.”
Unbilling effectively "untags” the transactions so they remain in work-in-process and do not get
updated. The field that is tagged is the Status field. When transactions are entered, they are typically
entered with a "P - Print" status. When a final statement is run, the transaction is changed to "U -
Update" indicating the transaction is ready to be updated. Unbilling the final statement changes the
status of all transaction that were on the final statement from "U - Update" back to "P - Print"
thereby canceling the final statement.

Unbilling statements must be done prior to running the Update Statements program. If a final
statement has already been updated, then you must use the Undo Updated Statement program to
reverse the update process.

E-mailing Statements

When statements are generated, statements for clients who are configured to receive mail
statements will be sent to the printer, whereas statements for clients who are configured to receive
e-mail statements will be sent to the E-mail Statements window. Statement delivery options are
configured in the Statement Delivery Options of the Client file (page 3). Once e-mail messages and
statements have been reviewed and updated, they can be automatically sent from the E-mail
Statements window.

The ability to e-mail statements from Tabs3 Billing requires either Microsoft Outlook or an SMTP
server and is designated on the Main tab of Tabs3 Billing Customization. If you select Outlook, no
further setup is required. If you select SMTP, you must configure the SMTP server in System
Configuration using the Settings | Outgoing E-mail Configuration program.

More Info: For additional information on e-mailing statements, see Tabs3 Billing Help or
Knowledge Base Article R11338, "E-mailing Tabs3 Statements."

E-mail Statements Window

Menu: Statements | E-mail Statements
Task Folders: Statements | E-mail Statements

Use the E-mail Statements window to manage e-mail statements; you can preview the e-mail
message that accompanies the statement and edit the To, Cc, Bcc, Subject, and Body fields, review
the PDF statement, mark the statement as reviewed or on hold, and send the statement from this
window.
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E E-mail Statements

101.00 willams A ohn

850,00 White/Kely Divorce

415.00 MegaCaonstruction Cor Corporate Merger - M James R. Tatiki, Sr.

860.02 whiteKely Medical Care of Briar Kelly &nn White

POF File Hame Timekesper H B S

i -om  |100.00 Stmt 7576 pof [1-ML) 4
jw2000Enet. com 101.00 Stmt 7581 paf 2PAM 11/26/2014
HE@megaconcop.com 41500 Stmt 7577 pdf 3RPA 11/26/2014  ToBe Updated
kelp@homeoffice.net  850.00 Stmt 7530 Dup.pdi KM 11/26/2014  ToBe Updated
kellw@homeoffice. net 85000 Sttt 7580 pf 2-PAM 11/26/2014  ToBe Updated

Hold | [ Feviewed | [view/EdtE-mai|

Options

Refresh

Hold

Reviewed

View/Edit E-mail

Figure 24, E-mail Statements window

The Options button can be used to display the E-mail
Statements Options window (Figure 25), which allows you
to limit the records shown in the E-mail Statements
window based on Client ID or Primary Timekeeper. This
window also allows you to display only e-mail statements
within a specific Statement Date range.

The Refresh button or F5 can be used to update the
information shown in the E-mail Statements window. Any
clients that no longer meet the e-mail statements options
will be removed. New final statements that have been run
for clients will replace the original PDF statements, except
when statements have been updated or are open at the
time of the refresh.

The Hold button can be used to mark the selected records
as "on hold." Check marks will be placed in the H (Hold)
column and the R (Reviewed) column. If the record was
already on hold, the check marks will be removed from the
H (Hold) and R (Reviewed) columns.

The Reviewed button can be used to mark the selected
records as "reviewed." A check mark will be placed in the
R (Reviewed) column. If the record was already marked as
reviewed, the check mark will be removed from the R
(Reviewed) column.

The View/Edit E-mail button can be used to open the E-
mail Preview window (Figure 26) to review and edit the e-
mail as well as view the attachment(s) that will be sent to
the client. The body of the e-mail is determined by the E-
mail Template assigned to the client. The E-mail Preview
window can also be used to send the e-mail, or mark the
e-mail as "on hold" or "reviewed."
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Send Reviewed

More Info: Additional information on creating E-mail
Templates can be found in Tabs3 Billing Help and the
Statement Formatting Guide.

The Send Reviewed button sends all e-mail statements
that have a check mark in the R (Reviewed) column of the
E-mail Statements window. Only statements that have
been updated can be sent. Therefore, if any statements in
the E-mail Statements window have been reviewed, but
not updated, you will be prompted to update statements
before the e-mail statements are sent.

Any statements that have a check mark in the H (Hold)
column along with a check mark in the R (Reviewed)
column will not be sent until the hold status is removed.

E-rnail Statements Options

Client
Client 1D:

Timekeeper

= Th - Multiple...

EX3

Frimary Timekeeper: = Th -

Staterment D ate

Statement D ate: mm.dd/yppy = Thue  mmdddumy -
0k l | Cancel | | Help

Figure 25, E-mail Statements Options window
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(= E-mail Preview - 850.02 White/Kelly = =n==
2 send | B Hold @ Reviewed | [ &2 | 96 6| @ €| ¢

BN B T UIESE=ic| =64

Fraom: ['Michael L. Jensen' <mienseni@iensenlaw. coms

Ta: "Kelly Ann Wwhite" <kelly@homeoffice. nets

Cze

Beo: adminialjenzenlaw. com

Subject; Invoice 7580 for Medical Care of Brianne

»

Client: Kelly Ann White I
Matter: Medical Care of Brianne

Dear Kelly Ann White,

Thank you for your previous payment of $0.00, which was received on mm/dd/yyyy.

m

Your current statement dated 11/26/2014 is attached. Please remit 53,402.50.

We appreciate the opportunity to serve vour legal needs.

Sincerely,

Paula Ann Martin

Jensen, Martin & Anderson, P.C.
1621 Cushman Drive

Lincoln, NE 68512

402-419-2200

.

850.00_5tm...

Figure 26, E-mail Preview window

E-mail Statements Report

Menu: Statements | E-mail Statements Report
Task Folders: Statements | E-mail Statements Report

The E-mail Statements Report shows all e-mail statements that are successfully sent to clients who
are set up to receive e-mail statements. For each e-mail that meets the selected criteria, the client, e-
mail date, recipient information, file name, statement date, and User ID of the sender are included in
the report, as shown in Figure 30.
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& E-mail Statements Report ; & E-mail Statements Report %
Clert [ Opiions | Sot._| § || [cient | ostons [sat_| 2
Client 1D: +  Thu: - } Py
N " 1 Report Date: | 11/26/2014 | ~ 1?
5 Report Criteria 3
‘T; Contact: ~  Thru: }
Name Search: Thru: g = . = £
i Statement Date:  mm/ddAyyyy Thru: - mmZAddAyyyy ?
Primary Timekesper: - Th: = Jé Email Date mm/ddAyy T Tp: mmddddyyy T \{
5 dary Timek «  Thu: -
econdary Timekesper n: y User [D- - T o )f
Criginating Timekeeper: «~  Thu: = j S
c T 9 Crientation 7
ategory 7 m i ] @ Portrait {:
3 () Landscape 3
Biling Frequency: @ Al () Specific Select Biling Frequency “} 3
) ) ) i Print ‘E
Location: @ Al () Specific \JI, [ Crteria Page §
Status @ Al () Specific 3 3
y . f ]
Open/Close Dates: @ Al () Specic Select Dates 1 ¢
H
3 i
! ;
1 4
2 5
Figure 27, E-mail Statements Report Figure 28, E-mail Statements Report
Client tab Options tab
@ E-mail Statements Report
Client | Options | Sort
Report Order Secondary Order
@ Primary Timekeeper @ Cliert ID
() Secondary Timekeeper () Cliert Name Search

() Originating Timekeeper () E-mail Date
Working Tim

[] Start Each Report Order on a New Page

AP gttt S BT, i N, i, i | e

Figure 29, E-mail Statements Report
Sort tab
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Client tab The Client tab allows you to specify a range of clients,
timekeepers, categories, billing frequencies, locations,
open dates, and close dates. You can also select clients
based on status (i.e., active clients, progress billing clients,
billable clients, e-mail and/or mail clients, and task based

billing clients).

Options tab The Options tab allows you to specify a range of contacts,
statement dates, e-mail dates, or user IDs.

Sort tab The Sort tab allows you to select the order in which the
information should appear on reports.

Date: 11/30/2014 Tabs3 E-mail Statements Report Fage: 1
Jensen, Martin & Andersen, P.C.
E-mail Date Contact E-mail Address PDF File Name Stmt Date User ID

101.00 Williams/John
RE: State v. Williams

1172072014 John Williams w2000 @net com 101.00_Stmt_75B80.pdf 11/30/2014 ROMN
121.01 Phillips/Marcus.
RE: Real Estate Acquisition

1172072014 Marcus Phillips markp@emach.net 121.01_Stmt_7578.pdf 11/30/2014 ROMN
200.01 Peterson Insurance Co.
RE: General Legal Counsel

11302014 Paul Franklin piranklini@petersoninsurance. com 200_Stmt_7577.pdf 11/30/2014 RON
415.00 MegaConstruction Corporation
RE: Corporate Merger - Megabuilders and BuilderCorp

113062014 James R. Tatiki, Sr. jt@megaconcorp.com 415.00_Stmt_7576.pdf 1173072014 RON
850.00 White/Helly
RE: Divorce

11/30/2014  Kelly White kelly_white_la@hushmail.com 850_Stmt_7579.pdf 11/30/2014 RON

1172072014 Kelly White kelly@homeoffice.net 850.00_Stmt_7570_Dup.pdf 11/30/2014 ROMN

Figure 30, Example of the E-mail Statements Report

Reprinting Statement Information

There are several methods for reprinting information that was included on a statement, depending
on the type of information you want. In this section, we will cover the Reprint Updated Statements
program, the Client Ledger Report, and the Transaction File List.

Reprint Updated Statement

Menu: Statements | Reprint Updated Statements | Reprint Single Updated Statement
| Reprint Multiple Updated Statement

Task Folders: Statements | Reprint Single Updated Statement
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The Reprint Single Updated Statement and Reprint Multiple Updated Statements programs allow you
to reprint a statements that has been updated. This enables you to easily reproduce previously billed
statements from any period.

Reprint Single Updated Statement

The Reprint Single Updated Statement ¢ Undo Single Updated Statement =8 EcR [
program allows you to reprint statements
one at a time Client 1D 121.0 ~  Philips/arcus

Fieal Estate Acquisition
Statement Mumber: 7595 -

Statement Information

Statement D ate: 104314204

Fees: 4254.10 Fee Tax 0.00
Eupenzes: 5225 Eupense Taw .00
Advances: 200.00 Advance Tax: 0.00
Finance Charge: ooo Payments: 269.93

Month to Adjust
Adjust period-bazed productivity reports for the following month;
@ Current Reporting Month: 1172014

Original Reporting Month in which the statement was updated:  10/2074

Date-bazed reports that included 1043142074 must be rerun
to reflect thiz change.

Figure 31, Reprint Single Updated Statement window

> To reprint a single updated statement
1. From the Tabs3 Billing Task Folders, click the Statements tab and then click the Reprint
Single Updated Statement icon.
2. Enter the Client ID for which you want to reprint a statement.
Select the Statement Number of the statement to reprint.
4. Click OK.
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Reprint Multiple Updated Statements

The Reprint Multiple Updated Statements
program allows you to reprint multiple
statements at one time.

» To reprint multiple updated statements

‘- Reprint Multiple Updated Statements [ =] )

Statement Criteria

Statement Date:  mm/ddAmmy = Thrw mmddddmy =

Client 1D: = Thiu <7 Multiple..
Mame Search: Thru:

Frimary Timekeeper: = Thiu: -

Secondary Timekeeper: = Thiu: -

Originating Timekeeper: = Thiu -

Category: = Thiu -

Reprint Options

PDFs as Individual Statements [Using DropBox or Piint to File/PDF)

Print Statement Fun Tatals

Naote: When statements are reprinted, Tabs3 uses the current statement template,
statement terminology, statement messages, printer settings, and statement designer
layout. Therefore, the layout of the reprinted statements may not exactly match the original
statements. Detailz regarding why reprinted statements may not exactly match the original
statements can be found in Help.

[ Ok ] | Cancel |

Figure 32, Reprint Multiple Updated Statements window

1. From the Statements menu, point to Reprint Updated Statements and select Reprint

Multiple Updated Statements.

2. In the Statement Criteria section, enter the desired criteria.

3. In the Reprint Options selection, optionally select to generate PDFS as Individual

Statements.
4. Click OK.

Client Ledger Report

Menu: Reports | Client Reports | Client Ledger Report

Task Folders: Reports | Management | Client Ledger Report

The Client Ledger Report shows the amount of payments, fees, expenses, advances, finance charge,
fee sales tax, expense sales tax, advance sales tax, and balance due for each statement. Payment
activity (including payment reversals), write offs, and balance due information are also included.
Detailed billed information that shows amounts billed by timekeeper and Cost Type can optionally
be included on the detail reports. A report showing only write offs can be generated.
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The following tabs are available in the Client Ledger Report:

@ Client Ledger Report

@ Client Ledger Report

Cliert 1D T . Thw 2

Name Search Thry

Primary Timekeeper: -~ Thru =

Secondary Timekeeper. +~ Thu =

QOriginating Timekeeper: -~ Thru =

Categary: = Thu -
Biling Frequency: @ Al () Specific Select Biling Frequency
Location: @ Al *) Specflic
Status @ Al *) Specflic Select Status..
Open/Close Dates @ Al *) Specfic Select Dates...

-Omions Format | Sort

Date
Report: /2272014 ~ WIP Pymt Cut-Off Date
Beginning: mm/ddAyyy Ending:
Prirt Type
Include Zero Balance Clients @ Detail
[ Group By Clisnt

[] Start Each Client on a New Page

[T Detail Information for each Statement
Detail Information for each Subtotal
[T Wit Offs Only

[ Criteria Page

() Summanry

f1/22/2014
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Figure 33, Client Ledger Report

Figure 34, Client Ledger Report
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Figure 35, Client Ledger Report
Format tab

Figure 36, Client Ledger Report
Sort tab
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Client tab The Client tab allows you to specify a range of clients,
timekeepers, categories, billing frequencies, locations,
open dates, and close dates. You can also select clients
based on status (i.e., active clients, progress billing clients,
billable clients, e-mail and/or mail clients, and task based
billing clients).

Options tab The Options tab includes parameters that enable you to
print a detail or summary report as well as specify what
type of information is included on the report (e.g., include
zero balance clients, detail information for each statement,
write offs only, etc.).

Format tab The Format tab allows you to optionally include
information such as reference numbers, hours, bill total,
and balance due as well as specify whether the report will
print portrait or landscape.

Sort tab The Sort tab allows you to select the order in which the
information should appear on reports.

» To run a Client Ledger Report
1. From the Tabs3 Billing Task Folders, click the Reports tab, click the Client Reports icon, and
then click the Client Ledger Report icon.
2. On the Client tab, select the desired Client ID or range of clients.
On the Options, Format, and Sort tab, select any other desired options.
4. Click OK.

Transaction File List

Menu: Reports | Transaction Reports | Transaction File List
Task Folders: Reports | Transactions | Transaction File List

The Transaction File List is one of our most flexible reports and can be used to determine which fees,
costs, and payments have been final billed and updated based on various options. The Transaction
File List is a means of sorting and listing fee, cost, and payment transactions stored in Tabs3 Billing.
This report can be used as an alternative to reprinting individual statements, as it can be configured
to print all final billed and updated transactions subtotaled in Statement Date order.

The following tabs are available in the Transaction File List:
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Figure 39, Transaction File List

Options tab

Figure 40, Transaction File List

Format tab
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Figure 41, Transaction File List
Sort tab

Client tab The Client tab allows you to specify a range of clients,
timekeepers, categories, billing frequencies, locations,
open dates, and close dates. You can also select clients
based on status (i.e., active clients, progress billing clients,
billable clients, e-mail and/or mail clients, and task based
billing clients).

Transactions tab The Transactions tab allows you to specify the
transactions to be included based on transaction type
(fees, costs, or payments), date, transaction code, working
timekeeper, category, and cost type.

Options tab The Options tab includes parameters that enable you to
print a detail or summary report as well as specify the type
of transactions you want to include on the report.

Tip: Be sure to select the Archived check box. Selecting
this option includes transactions on the report that have
been final billed and updated.

Format tab The Format tab allows you to specify which columns you
want to include and if you want to print the report in
portrait or landscape orientation. All columns are optional,
but at least one column must be selected.
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Sort tab The Sort tab allows you to select the order in which the
information should appear on reports.

» To run a Transaction File List for statements
1. From the Tabs3 Billing Task Folders, click the Reports tab, click the Transaction Reports
icon, and then click the Transaction File List icon.
2. On the Client tab, select the desired Client ID or range of clients.
On the Transactions tab, leave everything blank.

4. On the Options tab, in the Transaction section, clear the Work-In-Process check box and
select the Archived check box.

5. In the Date Selection section, select Statement.
6. On the Format tab, select the Statement Date check box.

7. On the Sort tab, in the 1st Sort Order section, select Client and select the Subtotal check
box,

8. In the 2nd Sort Order section, select Statement Date and select the Subtotal check box.

9. Click OK to print the report.

This is just one of the many ways to run the Transaction File List.

Date: 11/252014 Detail Transaction File List Page: 1
Jensen, Martin & Anderson
Trans Stmt H Tcode! Stmt # Hours
Client Date Date  Tmhkr P Task Code Rate o8Bl Amount
Client ID 104.00 Williams/John
101.00 08162014 090142014 3 A 10 160.00 125 200.00 Legal research.
101.00 08182014 09/01/2014 1 A 19 250.00 0.30 75.00 Initial Client Meeting
Subtotal for Statement Date 09/01/2014 Billable 125 200.00
Non-billable 0.30 75.00
Total 155 275.00
101.00 09/02/2014 093072014 1 A 18 250.00 2.50 525.00 Prepared for conference with client.
101.00 0940712014 09/30/2014 2 A 250 575 Long distance telephone charges.
101.00 09W09/2014  O9V30/2014 1A 201 7.50 Photocopy charges.
101.00 0902014 093072014 2 A 250 10.50 Long distance telephone charges.
101.00 0%/09/2014  09/30/2014 2 A 253 2.90 Postage.
101.00 ogrzizm4 09/30/2014 1 A 250 §.7% Long distance telephone charges.
101.00 091372014 093072014 1 A 3 250.00 0.25 52.50 Telephone conference with client.
101.00 09M16/2014  09/30/2014 1A 253 2.50 Postage.
101.00 09/28/2014 09/30/2014 A 800 200.00 Payment
Subtotal for Statement Date 09/30/2014 Billable 375 723.40
Payments 200.00
Total for Client ID 101.00 Billable 400 923.40 Wiliams/John
Non-billable 0.30 75.00 State v. Wiliams
Total 430 998 .40
Payments 200.00

Figure 42, Example of a Transaction File List
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Conclusion

Resources

Additional information on the features discussed in this guide can be found in the Tabs3 Billing
Help. Simply press F1 from anywhere within the software to load the Help information for that
particular topic.

Guides and Sample Statements
Additional guides and resources for separate software features are also available, including the
following:

e Statement Formatting Guide - This guide provides the information on the tools to give your

statements the look you want.

¢ Billing Methods Guide - This guide provides information on the various methods of billing
clients that are available in Tabs3 Billing. It includes information on basic billing concepts
that are important to individuals who enter client information in Tabs3 Billing.

e Tabs3 Billing Sample Reports - Over 20 pages of sample statements, and the formatting
options that were used to create the statements, can be found in the Tabs3 Billing Sample
Reports.

All guides and sample report packs are available on our Web site at:

Tabs3.com/support/docs.html

Knowledge Base
Our Knowledge Base can be accessed 24 hours a day, 7 days a week. You can also access our
Knowledge Base while in the software by selecting Help | Internet Resources | Knowledge Base.

e R11582 - "Statements Information Resources”, is a comprehensive list of KB Articles
containing more information about Tabs3 Billing statements.

e R11338 - E-mailing Tabs3 Statements

All Knowledge Base Articles are available on our Web site at:

support.Tabs3.com

- 38 -


http://www.tabs3.com/support/docs.html
http://www.support.tabs3.com/main/R11582.htm
http://www.support.tabs3.com/main/R11338.htm
http://www.support.tabs3.com/

Tabs3 Billing Statements Guide

Training Videos
Training videos are multimedia resources that walk you through Tabs3 Billing and PracticeMaster
features. Over 100 training videos are available, including the following:

e Statements Overview

e Pre-Bill Tracking
e E-mailing Statements

o Customizing Statements

All training videos are available on our Web site at:

Tabs3.com/trainingvideo/v17/video.html
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